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1  Introduction to CAT 

1.1  General Features  

 

The CAT (Client Administration Tool) is a powerful, Windows PC based, content management program which 

allows you to create playlists and remotely control the media for Celebration Toppers.  Media content can be 

in various forms, including MPEG video, JPG images, and MP3 or WAV audio files.  The various features 

allow a wide degree of content control options and scheduling possibilities. 

 

Note: This manual is specifically related to the CAT software.  For hardware set -up and options, please refer 

to the Celebration Topper user manual.  

 

The information in this manual refers to the various media player hardware options for the Celebration Topper, 

which are generically described here as model NP-xx.  The default player is the NP-30 model and is the 

most common option.  

1.2  Modes 

 

The following are some of the various modes that the CAT software can control:  

 

CF CARD MODE - Allows you to update your content by manually transferring to a CF card using in the 

Celebration Topper’s NP-xx media player. 

 

CAT MODE - Allows you to update the content of all your Celebration Topper’s NP -xx devices remotely via 

your LAN 

 

HTTP URL MODE allows you to create your playlists and upload them along with the associated media to a 

remote HTTP or FTP site. The Celebration Topper’s NP-xx device(s) are programmed to automatically 

download any new playlist and media. In this mode, no direct connection is needed between the remote 

device and the PC running CAT.  

 

HTTP IPOSTER MODE is similar to HTTP URL mode. The iPoster image file (.jpg) is uploaded to a fixed URL 

path. This mode setting instructs the topper’s media player  to check the defined URL for a new image within 

a programmable 5-99 seconds. If the file has a newer time stamp, the device will download the new image in 

the background and replace the current image.  

 

Note: The same filename must be used for each new image, and is only available for Celebration Toppers 

using the NP-30 media player.  



Celebration Topper CAT Software User Manual 
 

Revised : 6/15/2012 12:44:00 PM- JL    5 OF 37 
 

1.3  Playlists and Scheduling 

 

Playlists created with CAT are used by the Celebration Topper’s media player to control what and when media 

will be displayed.  Playlists created in CAT define:   

 

   The order your media will be shown.  

   How long each media will be shown (still images).  

   The time of day media will be shown.  

   The day of the week your playlist(s) media will be shown  

   The date range your playlist(s) media will be shown 

   The transition effect used between each media image  

   Where your media is stored 

a. Local drive 

b. Remote FTP server 

c. HTTP web location 

 

Additionally you can: 

 

   Create playlists for use weeks or months in advance  

   Upload images to your devices for future use 

   Set the time of day to update your media 

   Add text messages and RSS feeds in ticker format at the bottom of your screens.  

 

2  CAT Installation 
 

2.1  Software Installation 

 

Download the latest CAT software from Suzo-Happ and unzip to a temporary folder on your PC.  Run the 

CATSetup.exe program in order to install the CAT software on your PC.  The default installation directory is 

C:\Program Files\CAT, but you may choose a different location.  

 

IMPORTANT Firewall Setting: 

 

To allow your device(s) to connect to CAT make the following changes in your Firewall setting  

1. Go to your Windows Control Panel 

2. Double click on Windows Firewall 

3. Select the “Exceptions” Tab 

4. Check CAT or Client Administration Tool 
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Run the CAT.exe program, and check to make sure that program loads properly.   If the program does not 

load properly or error windows appear, please contact Suzo-Happ technical service for further instruction 

3  Initial Set-up  

 

3.1  Hardware Setup for CAT 

 

1.  Insert a formatted Compact Flash into the card slot on the Celebration Topper (refer to the Celebration 

Topper User Manual for detailed installation instructions).  

2.  Connect the network cable from the Celebration Topper to your LAN  

3.  Apply power to Celebration Topper.  

4.  Set-up the OPERATION MODE from the SETUP menu and then set the SERVER location and PLAYER 

IP from the NETWORK menu on the Celebration Topper (refer to the Celebration Topper user manual for 

detailed installation instructions regarding this step).  

 

If you are not sure of the IP address of your server location, run the CAT software, click on Tools, and then 

select Server Setup Utility:   

 

 

Next, click the update button.  Your PC’s IP address will the shown in the “Local IP Address” window.  

Record this IP address.  You will need to enter this address on the Server Setup Page.  Consult your IT 

department if assistance is necessary. 
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5.  Once the network settings are complete, cycle the power to the topper.  After the power cycle, the screen 

will show “INITIALIZING LAN”, “CONNECTING DHCP SERVER”, and then “MAIN MENU” will appear.  

 

6..  Run the CAT software by double clicking on the CAT desktop shortcut, and verify that the topper 

connects to the server.  When the topper is connected, the round status indicator dot on the screen will 

change from a red color to a green color to indicate that communication has been established:  

 

 

 

 

 



Celebration Topper CAT Software User Manual 
 

Revised : 6/15/2012 12:44:00 PM- JL    8 OF 37 
 

3.2  User Account Set-up  

 

The user account allows for set-up of the player name and creates password control.  Set-up is optional.  If 

no account name has been set-up, the topper will default to a name that includes the prefix “NE” followed by 

the last four digits of the MAC address. 

 
1.  Start the CAT software 

 

2.  Select Tools, and then Add/Edit Account 

 

3.  Select User Account and then Next 

 

 

4.  Select New to enter a new user account.  Enter the player name in the Account Name field and assign 

a password (optional).  The Default password is 123.  

 

 

5.  Enter information in the Description field for your own reference (optional).  

 

6.  Click Finish when your entries are complete.  

 

7.  Check to make sure that Celebration Topper is connected to the CAT server and shows the new account 

name..  
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3.3  Media Preparation 

 

1.  Create and/or convert your media files to match the standards necessary for playback:  

 

Video Formats: 

 MPEG-1, MPEG-2, MPEG-4, Divx  

Audio Formats: 

 WAV, MP3 (32K - 320K bps) 

Image Format: 

 JPEG (max resolution: 5120x3840) 

 

Suggested Video Settings: 

MPEG Video, with the following conditions: 

 Videos Created at 1280x720 

 Codec Information:  

a. MPEG2 Program Stream 

b. Field Dominance: Top First 

c. Aspect Ratio 16:9 

d. Frame Rate: 29.97 fps  

e. Bit Rate: 6.0 Mbps Constant  

f. Audio: 48000 Hz 192 kb/s Stereo 

 

2.  Store the media files that you want to add to your playlist in a convenient location on the server.  

 

Note:  It is recommended that media is stored on the server in an appropriately named folder on the server’s 

root directory.  This will make your media files easy to locate for playlist creation.  

 

Contact Suzo-Happ for the location of sample media or if you need HTTP or FTP storage space.  
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4   Using the CAT software 

 

4.1  Basic CAT Functions and Layout of User Interface  

 

 

 

Group List – Shows all active topper groups  

 

List of Active Toppers – List of all active toppers and the current status.  A green color indicator dot shows 

that the topper connection is established 

 

MPL Commander – This section is used for playlist creation and control.   The Brow se Window is used to 

navigate your computer for media folders, and the File List Window  is used to navigate the folder for 

individual media file selection.  The selected files for playback are shown in the Playlist Files window.  

 

Log Window  – Indicates the current activity and status for individual toppers.   

 

Status Bar – Indicates the status of the CAT software overall  
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4.2  Creating Media Playlists in CAT 

 

4.2.1  Selecting Files for the Playlist 

 

1.  Browse your computer using the CAT navigation window and locate the folder where your media files are 

stored.   

 

 

2.  Select the first file that you want to use for your playlist.  If the file is an image file, it will be shown in the 

preview window. 

 

3.  Add the file to the playlist by selecting the “>” button.  If you would like to add all files from the selected 

folder, select the “>>” button.   

 

4.  If the files are stored in a remote HTTP or FTP location, click the appropriate tab and enter the HTTP or 

FTP location address information.  

 

Remote HTTP Server: Enter the complete URL address and filename(s) for the files stored on a remote 

HTTP server.   There is a limit of two folder levels: yoursite.com/level1/level2/ filename.jpg  

 

Remote FTP Server: This function will instruct the device to log onto an FTP server. After selecting the 
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Remote FTP Server tab, click the “Property” button and complete the information necessary to connect to the 

FTP site, and then click “Connect”. The available files will appear in the center window. Select the files you 

wish to add to your playlist and move them to the right window using the “>” button.  
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5.  Once the desired files have been selected, they will be shown in the Playlist Files window.  The playlist 

header columns indicate the settings for individual media files, and allow customizing the playback options.  

The playlist control buttons allow you to change the order of files, delete unwanted items from the playlist, 

save and deploy playlists, as well as other editing functions: 

 

4.2.2  Playlist Columns 

 

The playlist columns show the various attributes of each media file.  The descriptions below explain each of 

the column headers and which attributes may be changed for further playlist control.  

 

 

 

Seq -Sequence of playlist files.  The order, starting from the top, defines the order that a playlist file will be 

played.  

 

File Name - Filename for each playlist file 

 

File Path - File location. This is the local, HTTP or FTP location of the media file  

 

Duration - How long each image file will appear in seconds  

 

From hhmm - The time of day that the file will be displayed.  If no entry, the default is 24hrs at 7 days per 

week 

 

To hhmm -Time of day that the file will stop being displayed.  If no entry, the default is 24hrs at 7 days per 

week  

 

Transition - A pull down menu allows for 13 different image transitions that may be used for image files : 

- Full screen (no effect) 

- Roll: top to bottom 

- Roll: bottom to top 
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- Roll: top/bottom to center 

- Roll: center to top/bottom 

- Blind: top to bottom 

- Roll: left to right  

- Roll: right to left  

- Roll: left/right to center 

- Roll: center to left/right 

- Roll: implode 

- Blind: left to right 

- Cross fade 

 

Reload - Reload the playlist file to the CF card 

 

D/L Only - Download a playlist file for future use.  The file will not be played until it is on an active playlist. 

 

4.2.3  Playlist Control Buttons 

 

 

Del – Delete a selected file from a playlist 

 

Clear – Clear/Delete an entire playlist 

 

Up Arrow – Move the selected file to a higher order in the playlist sequence.  

 

Down Arrow – Move the selected file to a lower order in the playlist sequence.  

 

Copy All – This feature can be used to copy the playlist and files directly to a CF card or to a USB flash drive 

for COPY or SYNC functions. 
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4.2.4  Global Playlist Settings 

 

Global playlist settings can be edited by selecting the Settings button.  Included are the following options:  

 

Note:  These optional settings must be selected and confirmed BEFORE saving your playlist  

 

 

Picture Play Timer – Default image display duration 

 

Use Global Transition – Ignore individual image transition settings  

- Full screen (no transition) 

- Random (from the 12 available transitions)  

- Cross Fade (all images will use the cross fade transition).  

 

Delete Files: 

- Format CF card  ( This option will delete all files in the CF card then download new files based on the 

playlist.mpl file) 

- Files not in playlist 

- Files in this playlist 

 

Mute Sound - Mute sound output  
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Download Schedule – Download ONLY at the time set. This option will write download time into playlist file. 

The topper will not start download until the download time is reached. The topper will start to download 

content according to this setting, NOT the reboot or restart time.  

 

4.2.5  Other Options Within the MPL Commander 

 

File Type:  

 

mpl: Use this file filter check box to list playlists (extension .mpl) only. This feature is to support multiple 

playlists with time range settings.  

 

yuv: This file filter is used f toppers with the NP-40 and NP-50 media player option only. See the 

respective user manual for details. 

 

NP-40 checkbox – This option is for toppers with the NP -40 media player option only.  The default is for this 

option to remain unchecked.  

 

4.2.6  Saving and Deploying the Playlist  

 

After the playlist has been completed and all desired options have been applied, the playlist can be saved and 

deployed to the selected toppers. The following are the relative options:  

 

 

 

Select Group/Device - The playlist will be sent only to a specific topper, or all toppers within a selected group 

 

Open – Open a previously saved playlist for editing or deployment.  

 

Save – Save the playlist for future retrieval and editing  
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EZ-Play – Select the EZ-Play to immediately deploy the playlist and media files to the selected topper(s).  

Note: If the topper is currently playing media, it must be stopped (stop button on the toolbar), prior to selecting 

EZ-Play and beginning the file transfer.  

 

Autoplay – Select the Autoplay button to delay the playlist and media transfer until the next power cycle or 

topper reset.  This option assigns a playlist (Autoplaylist.mpl) file for the specified group and enables 

Autoplay mode.  

 

4.3  Toolbar Functions 

 

The toolbar allows convenient access to some of the most common media control functions.   

 

 

4.3.1  Account and RSS edit tools 

 

Account 

 

Shortcut to Tools > Add/Edit Account (see section 4.4.2 for a detailed description)  

 

RSS Edit     

 

This control is used to add, edit or remove RSS feed links. 

 

Note: These options are available only when the device is connected directly to CAT.  

 

When selected, the following window will appear:  
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The settings in this window control whether or not the feed will be automatically set, and define the 

appearance of the feed.  Options include:  

 

Enable Auto RSS – This option will start the assigned RSS feeds automatically when the toppers log on the 

server running CAT.  When using this feature, there is no need to select the RSS icon to start the RSS feed 

manually. 

 

Background Color – This option sets the background color for the RSS ticker feed.  

 

Foreground Color – This option sets the foreground color for the RSS ticker feed.  

 

Transparent – This pull down menu gives the ability the set the transparency percentage of the RSS ticker 

feed bar.  

 

Speed – This option sets the speed of the feed for the RSS ticker.  Options are Normal (default ), Fast and 

Slow.  

 

Clock – A clock can be added to the display by using this option.  The clock may be set to “on” or “off” 

(default).  

 

Lead Characters – These are user defined characters that may be added as a prefix to the feed text.  The 

default is “>>”. 
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Adding a new feed: 

 

1. Select the Add Feed button from the top left corner of the RSS feed options menu. The following menu will 

appear: 

 

 

 

2. Enter the URL of the desired feed to add.  Example:  http://sports.espn.go.com/espn/rss/news 

3. Press the connect button to verify connection to the selected feed.  Once connected, the default title will 

be shown in the Feed Title section. 

4. Add the desired name for the feed in the Feed Title section (if something other than the default is desired).  

5. Select the desired topper group that will display the feed from the pull down Group menu.  

6. Select whether or not the feed should be active from the Active check box  

7. Select whether or not detailed news should be retrieved for the given feed by using the Detailed News 

checkbox.  If not checked, the RSS feed will display the header titles only.  

8.  Once all selections are complete, select the OK button on the Add New Feed menu.  

 

Right clicking on given feed title brings up a menu that allows you to Delete, Refresh, or define the Property 

associated with the feed.  The Property selection brings up the “Add New Feed” menu which will allow for 

editing of the existing feed attributes. 

 

 

 

http://sports.espn.go.com/espn/rss/news
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4.3.2  Group Tools  

 

Play, Stop, MSG, RSS, MSG OFF, Volume, Video, iPoster and Options are group commands.  These 

commands will be sent to all devices included in the selected group. 

 

 

 

Play 

 

Send a ‘Play’ command to the selected group of devices.  

 

Stop 

 

Send a ‘Stop’ command to the selected group of devices.  

 

MSG 

 

The MSG is an instant message “ticker” feed that can be sent for immediate display on the topper.  When 

selected, the Instant Message window will open:  
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You can browse and select any existing .txt file or manually type in text message, and then send to the group 

of toppers. This text will replace any current RSS feed and repeat until the MGS Off icon is clicked or the RSS 

feature is selected.    

 

If the text has been entered manually, the text and settings can be saved for future use by selecting the Save 

button, and choosing an appropriate file name.  The file can be retrieved at any time by selecting the MSG 

button again and typing the path and file name or choosing the location using the browse button.  

 

Menu options include:  

 

B/G – This option sets the background color for the text ticker feed.  

 

F/G – This option sets the foreground color for the text ticker feed.  

 

Transparent – This pull down menu gives the ability the set the transparency percentage of the text ticker 

feed bar.  

 

Speed – This option sets the speed of the feed for the text feed.  Opt ions are Normal (default), Fast and 

Slow.  

 

Clock – A clock can be added to the display by using this option.  The clock may be set to “on” or “off” 

(default).  

 

Encoding – Text encoding can be set as ANSI (default) or UTF-8 (Unicode encoding) 

 

RSS 

 

The RSS button starts sending the assigned RSS news ticker message(s) to the selected group of toppers. If 

the RSS ticker is already running, it will refresh the ticker information (if changed since the last update). 

 

MSG Off 

 

This option sends the “Message Off” command to the selected group of devices.  
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Volume 

 

This pull down menu allows for adjustment of the volume.  There are 15 levels of volume available, as wellas 

a mute function.  

 

 

 

Video 

 

This pull down menu controls the video display.  This option will turn the video ON or OFF for the selected 

group of toppers.  
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iPoster 

 

 

 

This feature sends a single still .jpg image immediately to the selected group of devices. The image will 

remain on the screen(s) until you replace it with another iPoster or restart your playlist.  There is also a 

checkbox option that can define a fixed time for display of the image file.  

 

Note: For best performance, the iPoster image resolution should be 1280x720 (16:9 ratio) or less to keep the 

file size small.  This will allow for a fast transfer of the file while maintaining the image quality.    

 

There are two methods to use the iPoster feature. One is from CAT and the other is in HTTP URL mode.  

 

CAT Method: 

Select the iPoster icon and a selection window will appear. Select your image file and click Open. A preview of 

the selected image will be displayed in the iPoster Image window on the left side of the CAT user interface.  

 

The desired display time can be chosen by selecting the Duration check box, and typing in the desired time (in 

seconds).  

 

 

Note:  The iPoster can be used alone, without the need for a playlist.  This can be useful for situations 

where the topper is used as a “billboard” to display a single image.  When a new image it to be displayed, 

just select the iPoster icon again, open another file, and send the new image.  The iPoster can also work  with 

RSS or “Instant Message” to scroll text on the display screen.  
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HTTP URL Method: 

Another way to send iPoster image is to use the “HTTP iPoster” operation mode.  This mode is similar to 

HTTP URL mode. You can place the image file to be displayed on a fixed URL path.  The media player in the 

topper will download this image file for display and will check the fixed URL path once per xx seconds (xx: 

programmable from 5-99). If the file’s time stamp is found to be newer that the existing file, the topper will 

download the new image in the background and replace the current image.  

 

In order to use this method, you will need to create a configuration file (autoconfig.mia) to store HTTP URL 

address.  The CAT Client Setup Utility can be used to create this file, or if it has already been created, you 

can use a text editor (such as Windows notepad) to add in the necessary information.  

 

If using a text editor, add the following lines in the [Preference]s group of the “autoconfig.mia” file. 

 

autoplay=xx ;xx = 5 to 99 

playlist=http://<url address>/ iposter filename.jpg  

 

For example:  

 

[Preference]  

autoplay=10 

playlist=http://na.suzohapp.com/images/r/rbm754sa1_xlrg.jpg  

 

Options 

 

This pull down Options menu can control the following:  

 

 

Format: Send quick format CF card command to device. 

Note: All files in CF card will be deleted. 

 

Reboot: Send reboot command to devices.  
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Group Status: Request all devices in the selected group to report their status. 

 

4.3.3  Device Tools 

 

Status, Capacity, CF Data and Playlist are individual device commands. These commands will be sent only 

to the selected toppers. No other toppers in a given group will be affected.  

 

 

 

 

Status 

 

This tool will request the selected topper to report its current status.  The status data may include the time, 

current playback filename, music, instant message, etc. 

 

Example:  

 

 

 

Property 

 

 

This tool will request the selected topper to report the CF card capacity and firmware version information.  
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Example:  

 

 

 

Note: The information in the Log Data window can be saved for future reference.  With the Log Data tab 

selected, move the mouse to the log window area and right click  to bring up a section menu.  The menu will 

allow options to “Save As” or “Clear”.  To save the log information, select the “Save As” option and choose an 

appropriate file name.  The file will be saved as a text file for later review.  This historical record can be 

useful for analysis and diagnosis if technical support is required. To clear the log window, select the “Clear” 

option.  All information in the log window will be erased  

 

 

 

CF Data 

 

 

 

This tool will request the selected topper to report a list of ALL filenames on the CF card (regardless of 

whether or not they are used in the active playlist). The topper media player must be stopped first in order to 

retrieve this report. Once ret rieved, select the CF Device tab to view the report.  

 

Example:  
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Right clicking on the files in the log window will bring up a menu option to delete selected files and/or folders.   

 

Note:  Files and folders that are chosen for deletion will be erased from the CF card. All files and directories 

can be erased, including the playlist. 

 

Playlist 

 

This tool will request a list of files for the current playlist.  Select the Playlist tab to view the report.  

 

Example:  

 

4.4  Menu Functions 

 

The Menu Functions refer to the top level menu options in the upper left section of the CAT program: 

 

 

4.4.1  Server  

 

Click “Server” once to display the pull -down menu 

 

 

 

Start (Ctrl+S): Starts CAT operations (selection will be unavailable if CAT is already active)  
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Stop (Ctrl+O): Stops all CAT operations.  

 

Protect Mode (F-11 key): This function protects against unauthorized use of CAT. After pressing the F-11 key, 

you must enter the administrator’s password to regain control of CAT. The factory default password is “admin”. 

To change the password, go to Tools > Change Password. Be certain to record the new password.  

Suzo-Happ cannot recover the password after it has been changed.  

 

Note: To restore the default password, you must re-install the CAT application.  

 

Backup: This function is used to backup user and group account settings . 

 

Restore: This function is used to restore user and group account settings.  

 

Exit: Exits the CAT program 

 

4.4.2  Tools 

 

Click “Tools” once to display the pull-down menu 

 

 

 

Add/Edit Account: Create, edit or delete GROUP(s) and DEVICE(s) User Accounts. 

 

Once the Add/Edit Account option has been selected, the following menu will prompt the user to select 

between a User Group or User Account options. 
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User Accounts 

 

Selecting this option will allow you to create a new user account, as well as edit or delete an existing user 

account.  After selecting “Next” the following window will be shown that will allow options for creating a new 

account, editing an existing account, or deleting an existing account  

 

 

 

New User Account Setup: 

   

1. Select “New” to create a new account and open the editing window 

2. Enter the player name in the Account Name field  

3. Assign a Password (optional).  The Default password is 123.  

4. Add a Description for the account (optional) 

5. Select Finish   

 

 

 

Editing an Existing User Account: 

 

1. Highlight an existing account and select “Edit” to edit an existing account and open the editing window.  

Make any changes necessary, and click “Finish” when editing is complete.  
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Note: The account can also be temporarily disabled by check ing the “Disable Account” check box 

  

Deleting an Existing User Account: 

 

1. Highlight an existing account and select “Delete” to delete an existing account  

 

Note: Once an account has been deleted, it cannot be retrieved  

 

User Group 

 

Selecting this option will allow you to create a new user group, as well as edit or delete an existing user group.  

After selecting “Next” the following window will be shown that will allow options for creating a new account, 

editing an existing account, or deleting an existing account  

 

 

 

New User Group Setup: 

   

1. Select “New” to create a new user group and open the editing window  

2. Enter the desired group name in the Group Name field  

3. Choose whether or not you want this group to use an Auto Playlist (checkbox) 

4. If using an Auto Playlist for the group, enter the file path manually or use the browse button to locate the 

AutoPlaylist.mpl file desired.  

5. Select Finish   

   



Celebration Topper CAT Software User Manual 
 

Revised : 6/15/2012 12:44:00 PM- JL    31 OF 37 
 

 

 

Editing an Existing User Account: 

 

1. Highlight an existing user group and select “Edit” to edit the group settings.  Make the desired changes 

and then click “Finish” when editing is complete.  

 

Deleting an Existing User Group: 

 

1. Highlight an existing user group and select “Delete” to delete the group 

 

Note: Once group has been deleted, it cannot be retrieved 

 

 

Server Setup Utility 

 

These settings are used by the administrator to make changes to the CAT server.  

 

 

Server: 

 



Celebration Topper CAT Software User Manual 
 

Revised : 6/15/2012 12:44:00 PM- JL    32 OF 37 
 

 

Server Port: 5021 is used for the port forwarding function of the network router to access the CAT program. 

 

NOTE: If the server port is changed, CAT must be closed and restarted for any port change to take effect. 

Consult your IT department if necessary.  

 

PASV: Port Start (default 5022) and Range (default 10) and can be changed to match your company’s 

firewall setting. Consult your IT department i f necessary.  

 

Check password when player login: This option can be selected if using an optional password.  The 

default is to have this box unchecked. 

 

Update button. Selecting this button will display your PCs IP address in the Local IP Address window.  

 

Startup: 

 

 

Application Startup Options 

These options define the CAT startup settings:   

-  Launch Control Server at Windows startup (default is unchecked)  

-  Startup minimized in system tray (default is unchecked) 

-  Automatically activate server at startup (default is checked)  

Log Settings 

-  Pull down menu allows for the following log detail levels 

 1-Normal 

 2-Detail  

 

Change Password: Set and change CAT password (optional). 
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RS232 Utility: This function is for future use.  

 

Playlist Scheduler: Define start date, stop date and days of the week multiple playlist(s) will run.  

 

These settings allow you to create a schedule of playlists that will begin play on the assigned Start date and 

stop on the assigned End date.  The Playlist Scheduler also allows you to schedule your program by day of 

the week. 
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Creating a playlist schedule: 

 

Before creating a schedule, make sure that you have created an .mpl playlist file for each playlist you would 

like to schedule.  Note that the default location for created playlist files is (\ProgramFiles\CAT\YourGroup\).  

 

1. Select the Brow se button and browse for the first playlist to be added to your schedule.  

 

2. In the Start date field, enter date you would like the schedule to begin. 

 

3. In the End date field, enter date you would like the schedule to end. 

 

4. Select the day(s) of the week (Sun – Sat) you would like your schedule to run. The playlist start time and 

end time are set in the individual playlists using the MPL Commander.  

 

Note: Check to be sure that your playlist dates and time schedules do not overlap. This may cause 

unexpected results. 

 

5  Select File > Save as to save your newly created schedule (filename.sch) into the appropriate group 

folder.  Example: CAT\YourGroup\YourSchedule.sch 

 

6.  Select Tools > Add/Edit Account > User Group and select the appropriate group. Next, select the Edit 

button. Check the Enable AutoPlay box and browse for your .sch file to enter into the Auto Playlist field. Click 

Finish when complete.  

 

7.  After completing these settings, CAT will return to the corresponding playlist(s) based on your .sch file 

when the topper logs into CAT.  

 

Client Setup Utility 

 

This utility can set the various attributes for the topper media player (client).  Included are the CAT server’s 

static IP address or Hostname, network port, device name & password, device DHCP or static IP address, 

device time zone, daylight savings time, restart time, on time, off time, video mode, Auto Start setting, and 

group assignment.  

 

Select Tools > Client Setup Utility and the following window will open: 
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Server IP 

 

IP or Hostname: Type in the IP address for the local LAN CAT server or the hostname for the remote 

internet server. Example: 192.168.1.100 or www.targeturl.com. 

 

Port: default is 5021. If 5021 is used elsewhere on the server side, consult your IT department for the 

appropriate entry.  

 

Client Device Setup 
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Account Name and Passwords should be unique to each device Enter the desired device Account Name 

and enter the device Password. After the device powers up and logs into CAT server, it will go to its matching 

group.  

 

Hide Main Menu: ON = Video on-screen menu will not appear on power up. OFF = Video on-screen menu 

will appear upon power up. 

 

File Repeat: Folder = Will play all files as specified in the playlist (Normal Operation). SINGLE = Will play 

only the first file in the playlist. 

 

Client IP Setup:  

 

Select DHCP (obtain dynamic IP from your router) or Static IP (fixed IP).  Consult your IT department for 

your specific needs. 

 

Device Daily Settings 

 

Restart time: When checked, this device will reboot and download new information daily at the 24 hour time 

set (HH:MM) 00:00 to 23:59. 

 

Device On/Off: This option can be used to turn the video ON and start the existing playlist at the first time 

entered (HH:MM) and will turn the video OFF and stop playing the existing playlist at the second time entered 

(HH:MM).  

 

Picture Rotate Mode:  

OFF: Picture has no rotation 

Clockwise: Picture will be rotated clockwise 90 degree. 

CNT-Clockwise: Picture will be rotated counter-clockwise 90degree.  

 

Note: This feature is only available on the NP-30 code V6.10.86.0118U or later version (RSS feed and 

date/time display are not currently available when picture is rotated).  

 

Client Time Setup 

 

Time zone:  Enter the appropriate zone for the device (Eastern time is GMT-5, Central time is GMT-6).  

 

Daylight saving:  If applicable, this selection will adjust the time (+1 hr) for this device. This setting must be 

manually changed when DST changes.  
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Date Format :  Set your preferred format from the pull down menu.  

 

Time Format :  Set your preferred time format (12/24) from the pull down menu.  

 

Client Video Output: 

 

This setting should always be set at VGA for the Celebration Topper  

 

Autostart – Operation Mode 

 

Selections include CAT, CF card, HTTP URL or ICAT 

 

Language: Factory setting as English. The CAT user interface and language can be customized upon request.  

Please contact your Suzo-Happ representative for additional information.  

 

4.4.3  View 

The View menu option allows you to select which window views will be displayed in the CAT software 

 

 

 

The optional window views are all selected by default.  Unchecking individual options will hide the chosen 

view.  

 

 

 

 

 

 

 

 

 

 


